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About this manual
Be sure to read this manual before using. This manual includes important 
information that you must understand before using rekordbox.
• In this manual, name of buttons and menus displayed on rekordbox are indicated 

with brackets. (e.g. [BPM], [Collection] window)
• Please note that depending on the operating system version, web browser 

settings, etc., operation may differ from the procedures described in this manual.
• Please note that the language on the rekordbox screen described in this manual 

may differ from the language on your screens.
• This manual describes functions and operations for rekordbox ver. 6.0 or later. If 

you use an earlier rekordbox version than ver. 6.0, please download the suitable 
manual from the FAQ on the rekordbox website.

• Please note that the specification, design, etc. of rekordbox may be modified 
without notice and may differ from the descriptions in this manual.
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Introduction

rekordbox is composite software that manages music files and DJ performances.
With this music management software, you can manage music files in computers 
and mobile devices (this includes analysis, changing settings, creating files, and 
saving playback histories). It allows you to produce great DJ performances by 
combining music files managed by rekordbox and DJ equipment produced by 
Pioneer DJ.

About subscription plan
By signing up a subscription plan, you can enjoy DJ performances using more 
functions.
For available functions on each subscription plan, refer to the rekordbox website.
rekordbox.com/en/plan/
Click [MY PAGE] in the upper-right of the screen to display the [MY PAGE] window, 
and then click the [PLAN] tab to check or change your current subscription plan. For 
details, see “Activating your computer with your subscription plan” (page 12).

Hint
• You can activate multiple computers and mobile devices with a single Pioneer DJ account. For 

the number of computers and mobile devices that you can activate for each subscription plan, 
refer to the rekordbox website.

• Even if you do not sign up a subscription plan, you can use more functions by connecting 
supported DJ equipment. For details, see “About authentication by DJ equipment (Hardware 
Unlock)” (page 11).
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Preparing rekordbox

Preparing rekordbox

Before using rekordbox, you need to install it and make settings.

Note
• For rekordbox ver. 6.0 or later, “rekordbox dj License Card” which is supplied with the Pionner 

DJ equipment cannot be used.
(It can be used to activate rekordbox dj (PERFORMANCE mode) on rekordbox ver. 5 or earlier.)
Depending on the DJ equipment, when you connect it to your computer, you can use limited 
functions of PERFORMANCE mode. For more details, see page 11.

Installing rekordbox
Before installing rekordbox, make sure to read “Software end user license 
agreement” (page 27).
If you are installing rekordbox, use the following procedures.
To install or uninstall rekordbox, you need to log on as the administrator of your 
computer. Have the administrator name and password ready before starting.

1 Launch a web browser on your computer, access the rekordbox website 
(rekordbox.com), and then open the rekordbox downloading page. 
Information about how to install rekordbox and how to use rekordbox features 
is displayed.

2 Click the button to download.

3 Read the terms of software license agreement carefully, and then click the 
[Agree] checkbox to continue.

4 Click [Download].
Downloading rekordbox will start.

5 Double-click the downloaded file to unzip it.

6 Double-click the unzipped file to launch the installer.

7 Follow the instructions on the screen to install rekordbox.
5



Preparing rekordbox
Launching rekordbox
Before starting rekordbox, log on as the computer’s administrator.
To use rekordbox for the first time, or if you have not already set up a Pioneer DJ 
account for another version of rekordbox, the windows for setting up a Pioneer DJ 
account will be displayed. Then with your computer connected to the internet, 
launch rekordbox and follow the instructions on the screen to do the following.
If an earlier rekordbox version than ver. 6.0 has been installed, you must first convert 
a previously used library to be used. For details, see “Converting the library of an 
earlier rekordbox version than ver. 6.0” (page 9).

Hint
• With your computer connected to the internet, you can access the online manual and support 

site from the [Help] menu on rekordbox.

For Mac
Select [Application] on the Finder, click the [rekordbox 6*] folder, and then double-
click [rekordbox.app].
* This number stands for a version number.

For Windows
Double-click the [rekordbox] icon (shortcut) on the desktop.
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Preparing rekordbox
1 Launch rekordbox.
The Pioneer DJ account setup window is displayed.

If you have already set up your Pioneer DJ account for an earlier rekordbox 
version, this window is not displayed. You can use rekordbox without 
procedures on this section.

2 Click [Create an account].

Setting up the Pioneer DJ account
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Preparing rekordbox

3 Enter your name, email address, password, and country.

If you want to receive emails containing Pioneer DJ news, click the checkbox.

4 Read the terms of service and privacy policy, and then click the checkbox if you 
agree with the terms.
If you disagree with terms, you cannot use rekordbox.

5 Click [Join Pioneer DJ].
An email with further account setup information will be sent to the email 
address you entered.
If you do not receive the email, check the junk folder of your email software.

6 Complete the setup by following the information in the email.

7 Go back to rekordbox, enter the account name and password, and then click 
[Setup].
rekordbox is available to be used by clicking [OK].

If using a Mac computer, you will be asked to input a password. Enter the 
administrator’s password of your Mac. If using a Windows computer, you will be 
asked if you allow rbinit.exe to make changes on your computer. Confirm the 
publisher, and then click [Yes].

Entering administrator’s password (Mac) / 
Allowing user account control (Windows)
8



Preparing rekordbox
If you use the library of an earlier rekordbox version than ver. 6.0, you need to 
convert it. (You can create an empty library without using the library of an earlier 
rekordbox version.)
When you start rekordbox and answer the questions shown on the screen, the 
following screen is displayed.

1 Click [NEXT].

2 Click [START].
The library conversion will start.
Click [NEXT] if you are not using the library of an earlier rekordbox version than 
ver. 6.0.

Hint
• To cancel the library conversion, click [CANCEL]. You will need to convert the library again.
• Even if you cancel the library conversion or do not convert the library, you can convert it later. 

Select [Import your library from ver. 5 (or earlier)] from [Library] in the [File] menu at the top of 
the screen.

Note
• If there is not enough free space on the computer drive, an error screen appears. Check your 

computer’s free space, and then click [Retry] to start the library conversion again.
• The library conversion may take time, and you cannot use rekordbox until the conversion is 

complete.

Converting the library of an earlier rekordbox 
version than ver. 6.0
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Preparing rekordbox
Click [Choose your plan] to open the rekordbox website (rekordbox.com), and sign 
up a subscription plan. For details on subscription plans, refer to “Compare plans” 
on the rekordbox website.
rekordbox.com/en/plan/
Click [Click to proceed] if you have already signed up a subscription plan or do not 
want to sign up one.

Note
• The information on the above window is just an example. For actual prices and applicable 

services, refer to the rekordbox website.

When the [Choose your plan] window is 
displayed
10
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Setting up rekordbox
• “About authentication by DJ equipment (Hardware Unlock)” (page 11)
• “Activating your computer with your subscription plan” (page 12)
• “Setting up KUVO” (page 13)
• “Installing the audio driver” (page 14)
• “Setting up the audio output” (page 14)

Depending on the Pioneer DJ equipment, when you connect the DJ equipment to 
your computer on which rekordbox is installed, you can use limited functions, such 
as recording in the PERFORMANCE mode and the DVS function, without signing 
up a subscription plan. For details on supported DJ equipment, refer to the 
rekordbox website.
rekordbox.com/en/support/faq/v6/#faq-q1525
Refer to the Instruction Manual of the connected DJ equipment.

About authentication by DJ equipment 
(Hardware Unlock)
11
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Preparing rekordbox
By signing up a subscription plan, you can use rekordbox on multiple computers by 
logging in to them with the same Pioneer DJ account, and use limited functions.
Click [MY PAGE] in the upper-right of the screen to display the [MY PAGE] window, 
click the [PLAN] tab, and then activate your computer.

1. Your current subscription plan

2. Next billing date for your current subscription plan

3. History for your subscription plan

4. Turn the activation on/off.

5. Expiration Date for your current subscription plan

6. Click here and select the following.
[Change/cancel your plan]: Change or cancel your subscription plan.
[Subscribe to a plan]: Sign up a subscription plan.
[Check for active devices]: Check the activation status on other computers and 
mobile devices.
For details and notes on updating a subscription plan, check the FAQ provided 
on the rekordbox website.

Activating your computer with your 
subscription plan

1

2

4

5

6

3
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Preparing rekordbox

Hint
• If you use the same Pioneer DJ account, you can activate multiple computers and mobile 

devices with a single subscription plan. The number of computers and mobile devices that you 
can activate is limited in accordance with your subscription plan. Therefore, if you purchase a 
new computer and use it with rekordbox, deactivate an old one first.

You can set your DJ performance information to be public or not. Click [MY PAGE] 
in the upper-right of the screen to open the [MY PAGE] window. Click the [KUVO] 
tab to set up KUVO.
For details on how to upload files to KUVO, refer to “rekordbox Instruction Manual” 
on the rekordbox website.

1. User name of the KUVO profile (DJ name when publishing KUVO)

2. Open the KUVO website and change your user name.

3. Set the performance information for all tracks to public/private.

|To use KUVO
Refer to the configuration guide.
http://kuvo.com/kuvoweb/docs/configulation_guide/ConfigurationGuide.pdf

Setting up KUVO

1 2

3
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Preparing rekordbox
When connecting Pioneer DJ equipment to the computer, the driver installation 
screen is displayed. Follow the instructions on the screen to install the driver. For 
details, refer to the Instruction Manual of the Pioneer DJ equipment.

Click  in the upper-right of the screen to open the [Preferences] window, and then 
select the speaker on [Audio] of the [Audio] tab.

Installing the audio driver

Setting up the audio output
14



Preparing rekordbox
About [MY PAGE]
Click [MY PAGE] in the upper-right of the screen to open the [MY PAGE] window.
The currently logged-in Pioneer DJ account is displayed in the upper-right of the 
screen. You can switch the Pioneer DJ account.

1. Notifications from the rekordbox website (rekordbox.com) are displayed.
When you click the [Display at startup only when new information is available.] 
checkbox at the bottom of the screen, you can set notifications to stop being 
displayed when rekordbox starts if there are no new notifications.

2. Check or change your current subscription plan. (page 12)

3. Set the Cloud Library Sync function.
For details, refer to “Cloud Library Sync Operation Guide” on the rekordbox 
website.

4. Set KUVO to be public or not. (page 13)

5. Pioneer DJ account is displayed.
When you click here and select [Switch Account], you can switch the Pioneer DJ 
account.
When you click here and select [Change Profile], you can change the profile of 
your Pioneer DJ account.

6. Close the [MY PAGE] window.

1

5

6

2 3 4
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EXPORT mode and PERFORMANCE mode

EXPORT mode and PERFORMANCE mode

rekordbox provides two modes for your DJ set preparation and DJ performance.
Click [EXPORT] or [PERFORMANCE] in the upper-left of the screen to change the 
mode.

About the EXPORT mode
When using the CDJ/XDJ series, rekordbox supports DJ performances which use 
waveforms, cues, loops, beat sync, etc. by analyzing music files before starting.

You can enjoy various DJ performances using PRO DJ LINK by adding music files, 
which are stored in your computer and USB storage device, to [Collection] of 
rekordbox and managing them.
PRO DJ LINK has two export functions. Use USB EXPORT to export a managed 
library of music files or playlists to a USB storage device or SD card. The USB 
storage device or SD card is inserted into a DJ player. Use LINK EXPORT to 
connect the computer to the DJ player. In both functions, you can share music files, 
playlists, etc. with DJ equipment on the same network. For details of PRO DJ LINK, 
refer to “Using with DJ equipment (PRO DJ LINK)” of “rekordbox Instruction Manual” 
on the rekordbox website.
* LINK EXPORT is available only in the EXPORT mode.
You can enjoy simple DJ mix with the [2 PLAYER] mode.
16



EXPORT mode and PERFORMANCE mode
About the PERFORMANCE mode
Use the PERFORMANCE mode for DJ mix performance on rekordbox. You can 
enjoy professional DJ performances with up to 4 decks, 16 samplers, and various 
features including the effect function.

Depending on your subscription plan, some functions may not be available.
For details on subscription plans, refer to “Compare plans” on the rekordbox 
website.
rekordbox.com/en/plan/

Download and install the sample pack
You can download “sample pack” audio files which can be used for the rekordbox 
sampler. Select [Sample Pack] > [Download Sample Pack] from the [File] menu at 
the top of the screen. Downloading will start. After downloading, select [Import 
Sample Pack], and then select the downloaded file. The downloaded file will be 
imported to rekordbox. After the import, you can use the audio files for the sampler.
17
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Others

System requirements
Before installing rekordbox, make sure to read “Software end user license 
agreement” (page 27).

|Supported OS
The latest information (supported OS, required operating environment, etc.) is 
available on the rekordbox website.
rekordbox.com/en/download/#system

|Required system (minimum required operating environment)
Make sure that your computer meets the following system requirements before 
installing rekordbox. For details on the latest information, refer to the rekordbox 
website.
• CPU: 2.5 GHz dual-core Intel®processor Core™ i5
• Memory: 8 GB (or more) RAM
• Hard disk/SSD: 2 GB (or more) free space (excluding space necessary for storing 

music files)
• Display resolution: 1 280 × 768 (or larger)
• Sound: Audio output to speakers, headphones, etc. (built-in or external audio 

device)
• Internet connection: For the account registration or inquires, use a web browser 

supporting 128-bit SSL (e.g. Safari 10 or later, Internet Explorer® 11 or later).
• USB port: A USB port is required to transfer music files to a USB storage device 

(flash memory, hard disk, etc.) or to connect to a DJ controller.
• LAN port: An Ethernet LAN adapter (RJ45 port) is required for communication with 

DJ equipment to transfer music files to a PRO DJ LINK compatible CDJ/XDJ 
series, etc. For details, refer to the Instruction Manual of the Pioneer DJ product.

Note
• Full functionality is not guaranteed with all computers even when the above operating 

environment conditions are fulfilled.
18

https://rekordbox.com/en/download/#system


Others

• Even with the required memory capacity indicated for the operating environment above, 

rekordbox may not provide full functionality and performance due to lack of memory in the cases 
described below. Take the necessary measures to ensure sufficient free memory. Adding extra 
memory, in order to achieve stable performance, is recommended.
– When there are many tracks being managed in the rekordbox library.
– When resident programs and services are running.

• Depending on your computer’s power saving settings, it may not be possible for your computer 
to achieve its optimum CPU and/or hard-disk processing capacity. Especially with a laptop 
computer, use an external AC power source to ensure best performance when using rekordbox.

• rekordbox may not operate properly if combined with other programs installed on your computer.
19
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Communications environment on the 
computer
Depending on your computer’s security software and operating system settings, 
communications with DJ equipment or mobile devices may be interrupted. If this 
occurs, check your settings for the following 7 programs to ensure that they are not 
blocked. The program extension depends on the OS of the computer; e.g. the 
extension “.app” is for Mac and “.exe” for Windows:

rekordbox
PSvNFSd
PSvLinkSysMgr
edb_streamd
ls-unity-rekordbox-win
rbhttpserver
rbcloudagent.exe

When sharing of the computer’s internet connection is enabled, problems may arise 
in communications with other computers or DJ units connected on the LAN. Disable 
sharing before connecting the computer to the LAN.
• Mac: Open [System Preferences], and uncheck [Internet Sharing] under 

[Sharing].
• Windows: Open [Local Area Connection Properties], and then at [Sharing], 

uncheck [Allow other network users to connect through this computer’s Internet 
connection] under [Internet Connection Sharing].

Communications with DJ equipment or mobile devices may also be interrupted if the 
network (IP address, port number, etc.) is restricted by a router or another 
communications device.
For details on the communications devices, security software, and the settings of 
the operating system, contact the respective manufacturer or your sales agent.
20



Others
File formats that can be loaded and 
played
Files that can be loaded and played on rekordbox are listed below.
• It may not be possible to read or play copyright-protected music files.
• For music files (file formats) that can be loaded and played on DJ equipment 

produced by Pioneer DJ, refer to the Instruction Manual of the DJ equipment.

|Music files
Music 
file

Compatible 
formats

Encoding 
method

Bit 
depth

Bit rate Sampling 
frequency

File 
extension

MP3 MPEG-1 
AUDIO 
LAYER-3

CBR
VBR

16 bit 32 kbps to 
320 kbps

32 kHz
44.1 kHz
48 kHz

.mp3

MPEG-2 
AUDIO 
LAYER-3

CBR
VBR

16 bit 16 kbps to 
160 kbps

16 kHz
22.05 kHz
24 kHz

.mp3

AAC MPEG-4 
AAC LC

CBR
VBR

16 bit 8 kbps to 
320 kbps

16 kHz
22.05 kHz
24 kHz
32 kHz
44.1 kHz
48 kHz

.m4a

.mp4

WAVE Uncompressed 
PCM

16 bit
24 bit

— 44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.wav

AIFF Uncompressed
PCM

16 bit
24 bit

— 44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.aif

.aiff
21



Others
|Video Files
• File extension: mpg, mp4, m4v, avi (Windows), qtz (Mac)
• Video format

– Codec: h.264, mpeg-4, mpeg-2
– Display resolution: up to 1 920 × 1 080

• Audio format: LPCM (aiff), aac, mp3

| Image files
• File extension: jpeg, png, gif (animated gif files are not supported)
* Depending on the OS or the operating environment of your computer, some files may not be 

imported or played.

Apple Lossless Compressed 
PCM

16 bit
24 bit

— 44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.m4a

FLAC Compressed 
PCM

16 bit
24 bit

— 44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.flac

.fla

Music 
file

Compatible 
formats

Encoding 
method

Bit 
depth

Bit rate Sampling 
frequency

File 
extension
22



Others
Supported media (file system)
Note that rekordbox can only write to SD memory cards and USB storage devices 
(flash memories or hard disks) which use a file system listed in the table below.

• To check the compatibility of SD memory cards and USB storage devices (flash 
memories or hard disks) with your DJ equipment produced by Pioneer DJ, refer to 
the Instruction Manual of the DJ equipment.

• HFS+ is available for Mac.

Recording 
media

FAT16 FAT32 NTFS HFS HFS+

SD memory 
cards

N/A N/A N/A

USB storage 
devices

N/A N/A
23
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Online support site
Before making inquiries on rekordbox operating procedures or technical issues, 
read this manual and check the FAQ provided on the rekordbox website.
• AlphaTheta Corporation collects your personal information for the following 

purposes:
1. To provide customer support for your purchased product
2. To inform you of product or event information via e-mail
3. To obtain feedback collected by survey for product planning purposes
– Your personal information is kept confidential corresponding to the privacy policy 

set forth by our company.
– AlphaTheta Corporation's privacy policy can be viewed on the rekordbox online 

support site.
• When making inquiries regarding rekordbox, please be sure to let us know your 

computer type and specifications (CPU, installed memory and other connected 
peripherals, etc.), the operating system and version used, as well as concrete 
information regarding the issue at hand.
– To inquire about configuration of your computer with non-AlphaTheta 

Corporation peripheral devices
and to obtain the corresponding technical support, contact the manufacturer or 
retailer.
• Further version updates are anticipated for improved functionality and 

performance of rekordbox. Update programs will be available for download on the 
rekordbox online support site. We strongly recommend you check for the updates 
to always use the latest version of rekordbox.
24
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Disclaimer
Please note that AlphaTheta Corporation cannot accept responsibility for the 
legality, morality or reliability of operation with regard to the use of rekordbox by 
customers. Problems in operation of rekordbox may arise due to the operating 
environment of the customer’s computer and of rekordbox, or conflict with other 
software.
Please note that AlphaTheta Corporation cannot accept responsibility for loss of 
your registered information. Please make a separate note of information you have 
registered and store it in a safe place.
25
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Copyright warning
The use of rekordbox is restricted with regard to the playing and copying of copy-
protected music.
• The program may not operate properly if copy-protect encryption data is 

embedded in recorded media.
• Playback, analysis, and other operations may stop if copy-protect encryption data 

is detected as embedded in recorded media.
The material you record is for your own listening enjoyment, and cannot be used for 
other purposes without permission from the copyright owner.
• Music recorded from CDs and other media may be protected by the copyright laws 

of individual countries as well as by international convention. You are solely 
responsible for the lawful use of the recordings you make.

• When handling music that has been downloaded over the internet, the person who 
has downloaded the music is fully responsible for using the music in compliance 
with his/her contract with the website from which the music was downloaded.
26
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Software end user license agreement
This Software End User License Agreement (“Agreement”) is between you (both the 
individual installing the Program and any single legal entity for which the individual 
is acting) (“You” or “Your”) and AlphaTheta Corporation (“AlphaTheta”).
TAKING ANY STEP TO SET UP OR INSTALL THE PROGRAM MEANS THAT YOU 
ACCEPT ALL OF THE TERMS OF THIS LICENSE AGREEMENT. PERMISSION 
TO DOWNLOAD AND/OR USE THE PROGRAM IS EXPRESSLY CONDITIONED 
ON YOUR FOLLOWING THESE TERMS. WRITTEN OR ELECTRONIC 
APPROVAL IS NOT REQUIRED TO MAKE THIS AGREEMENT VALID AND 
ENFORCEABLE. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS 
AGREEMENT, YOU ARE NOT AUTHORIZED TO USE THE PROGRAM AND 
MUST STOP INSTALLING IT OR UNINSTALL IT, AS APPLICABLE.

1. DEFINITIONS
1.1 “Documentation” means written documentation, specifications and help content 
made generally available by AlphaTheta to aid in installing and using the Program.
1.2 “Program” means all or any part of AlphaTheta’s software licensed to You by 
AlphaTheta under this Agreement.

2. PROGRAM LICENSE
2.1 Limited License. Subject to this Agreement’s restrictions, AlphaTheta grants to 
You a limited, non-exclusive, non-transferable, license (without the right to 
sublicense):

(a) To install a single copy of the Program in Your computer or mobile device, to 
use the Program only for Your personal purpose complying with this Agreement 
and the Documentation (“Authorized Use”);
(b) To use the Documentation in support of Your Authorized Use; and
(c) To make one copy of the Program solely for backup purposes, provided that all 
titles and trademark, copyright and restricted rights notices are reproduced on the 
copy.

2.2 Restrictions. You will not copy or use the Program or Documentation except as 
expressly permitted by this Agreement. You may transfer the Program (when the 
Program is transferred related license is also transferred without any procedure), 
but will not sublicense, rent, lease or lend the Program, or use it for third-party 
training, commercial time-sharing or service bureau use. You will not Yourself or 
through any third party modify, reverse engineer, disassemble or decompile the 
Program, except to the extent expressly permitted by applicable law, and then only 
after You have notified AlphaTheta in writing of Your intended activities.
27



Others

2.3 Usage of Lyrics. Usage of Lyrics is limited to your personal, noncommercial use 
in accordance with the terms of this Agreement. You may not reproduce (other than 
as authorized for your own personal usage), publish, transmit, distribute, publicly 
display, rent or lend, modify, create derivative works from, sell or participate in the 
sale of or exploit in any way, in whole or in part, directly or indirectly, any of the Lyrics 
so provided. You agree that you are not granted any so-called “karaoke” or “sing-
along” rights to Lyrics and you shall not seek to or remove any vocal track from a 
sound recording that shall be associated with a Lyric provided to you. You agree not 
to assign, transfer or transmit any Lyrics to any third party. You agree that you shall 
not seek to or do anything that will defeat, evade or circumvent any efforts that may 
be made to protect the Lyrics from any unauthorized usage. Licensee also agrees 
that except as specifically authorized herein, the foregoing restrictions apply to their 
use of Lyrics.
2.4 Ownership. AlphaTheta or its licensor retains all right, title and interest in and to 
all patent, copyright, trademark, trade secret and other intellectual property rights in 
the Program and Documentation, and any derivative works thereof. You do not 
acquire any other rights, express or implied, beyond the limited license set forth in 
this Agreement.
2.5 No Support. AlphaTheta has no obligation to provide support, maintenance, 
upgrades, modifications or new releases for the Program or Documentation under 
this Agreement.

3. WARRANTY DISCLAIMER
THE PROGRAM AND DOCUMENTATION ARE PROVIDED “AS IS” WITHOUT 
ANY REPRESENTATIONS OR WARRANTIES, AND YOU AGREE TO USE THEM 
AT YOUR SOLE RISK. TO THE FULLEST EXTENT PERMISSIBLE BY LAW, 
ALPHATHETA EXPRESSLY DISCLAIMS ALL WARRANTIES OF ANY KIND WITH 
RESPECT TO THE PROGRAM AND DOCUMENTATION, WHETHER EXPRESS, 
IMPLIED, STATUTORY, OR ARISING OUT OF COURSE OF PERFORMANCE, 
COURSE OF DEALING OR USAGE OF TRADE, INCLUDING ANY WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
SATISFACTORY QUALITY, ACCURACY, TITLE OR NON-INFRINGEMENT.

4. EXPORT CONTROL AND COMPLIANCE WITH LAWS AND REGULATIONS
You may not use or otherwise export or re-export the Program except as authorized 
by United States law and the laws of the jurisdiction in which the Program was 
obtained. In particular, but without limitation, the Program may not be exported or 
re-exported (a) into any U.S.-embargoed countries or (b) to anyone on the U.S. 
Treasury Department’s Specially Designated Nationals List or the U.S. Department 
of Commerce Denied Persons List or Entity List. By using the Program, you 
28
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represent and warrant that you are not located in any such country or on any such 
list. You also agree that you will not use the Program for any purposes prohibited by 
United States law, including, without limitation, the development, design, 
manufacture, or production of nuclear, missile, or chemical or biological weapons.

5. U.S. GOVERNMENT RESTRICTED RIGHTS
The Program and Documentations are “commercial computer software” and 
“commercial computer software documentation” as those terms are defined in 48 
C.F.R. §252.227-7014 (a) (1) (2007) and 252.227-7014 (a) (5) (2007). The U.S. 
Government's rights with respect to the Program and Documentations are limited by 
this license pursuant to 48 C.F.R. § 12.212 (Computer software) (1995) and 48 
C.F.R. §12.211 (Technical data) (1995) and/or 48 C.F.R. §227.7202-3, as 
applicable. As such, the Program and Documentations are being licensed to the 
U.S. Government end users: (a) only as “commercial items” as that term is defined 
in 48 C.F.R. §2.101 generally and as incorporated in DFAR 212.102; and (b) with 
only those limited rights as are granted to the public pursuant to this license. Under 
no circumstance will the U.S. Government or its end users be granted any greater 
rights than we grant to other users, as provided for in this license. Manufacturer is 
AlphaTheta Corporation, Yokohama i-Mark Place 6F, 4-4-5 Minatomirai, Nishi-ku, 
Yokohama-city, Kanagawa prefecture, Japan, ZIP: 220-0012

6. DAMAGES AND REMEDIES FOR BREACH
You agree that any breach of this Agreement’s restrictions would cause AlphaTheta 
irreparable harm for which money damages alone would be inadequate. In addition 
to damages and any other remedies to which AlphaTheta may be entitled, You 
agree that AlphaTheta may seek injunctive relief to prevent the actual, threatened 
or continued breach of this Agreement.

7. TERMINATION
AlphaTheta may terminate this Agreement at any time upon Your breach of any 
provision. If this Agreement is terminated, You will stop using the Program, 
permanently delete it from your computer or mobile device where it resides, and 
destroy all copies of the Program and Documentation in Your possession, 
confirming to AlphaTheta in writing that You have done so. Sections 2.2, 2.3, 2.4, 3, 
4, 5, 6, 7, 8 and 9 will continue in effect after this Agreement's termination.

8. GENERAL TERMS
8.1 Limitation of Liability. In no event will AlphaTheta or its subsidiaries be liable in 
connection with this Agreement or its subject matter, under any theory of liability, for 
any indirect, incidental, special, consequential or punitive damages, or damages for 
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lost profits, revenue, business, savings, data, use, or cost of substitute procurement, 
even if advised of the possibility of such damages or if such damages are 
foreseeable. In no event will AlphaTheta’s liability for all damages exceed the 
amounts actually paid by You to AlphaTheta or its subsidiaries for the Program. The 
parties acknowledge that the liability limits and risk allocation in this Agreement are 
reflected in the Program price and are essential elements of the bargain between 
the parties, without which AlphaTheta would not have provided the Program or 
entered into this Agreement.
8.2 The limitations or exclusions of warranties and liability contained in this 
Agreement do not affect or prejudice Your statutory rights as consumer and shall 
apply to You only to the extent such limitations or exclusions are permitted under the 
laws of the jurisdiction where You are located.
8.3 Severability and Waiver. If any provision of this Agreement is held to be illegal, 
invalid or otherwise unenforceable, that provision will be enforced to the extent 
possible or, if incapable of enforcement, deemed to be severed and deleted from 
this Agreement, and the remainder will continue in full force and effect. The waiver 
by either party of any default or breach of this Agreement will not waive any other or 
subsequent default or breach.
8.4 No Assignment. You may not assign, sell, transfer, delegate or otherwise 
dispose of this Agreement or any rights or obligations under it, whether voluntarily 
or involuntarily, by operation of law or otherwise, without AlphaTheta’s prior written 
consent. Any purported assignment, transfer or delegation by You will be null and 
void. Subject to the foregoing, this Agreement will be binding upon and will inure to 
the benefit of the parties and their respective successors and assigns.
8.5 Entire Agreement. This Agreement constitutes the entire agreement between 
the parties and supersedes all prior or contemporaneous agreements or 
representations, whether written or oral, concerning its subject matter. This 
Agreement may not be modified or amended without AlphaTheta’s prior and 
express written consent, and no other act, document, usage or custom will be 
deemed to amend or modify this Agreement.
8.6 You agree that this Agreement shall be governed and construed by and under 
the laws of Japan.

9. RESTRICTIONS TO INFRINGEMENTS OF COPYRIGHT PROTECTED DATA 
OWNED BY THIRD PARTY
When using the program, You must agree on the following:

(a) To follow copyright protection laws, rules and regulations designated in every 
country and international treaties;
(b) To legally obtain music data used in the Program;
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(c) Not to bypass or decode Digital Rights Management technology implemented 
to the data.

In addition, you may not copy music data beyond the extent of private use. You may 
not give or transfer music data to third party. You may not share or intend to share 
the media or storage used to save music data with others. You may not save music 
data to media or storage which allows access to third party. You may not provide live 
distribution of such music data to third party.
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Trademarks and licenses
• rekordbox™ is a trademark or registered trademark of AlphaTheta Corporation.
• PRO DJ LINK™ is a trademark or registered trademark of AlphaTheta 

Corporation.
• Windows is a registered trademark of Microsoft Corporation in the U.S. and other 

countries.
• iPhone, Apple Music, iTunes, Mac, and macOS are trademarks of Apple Inc., 

registered in the U.S. and other countries.
• iOS is a trademark containing Cisco trademark signs in the U.S. and other 

countries.
• App Store is a service mark of Apple Inc.
• Android, Google Play, YouTube, and YouTube logo are registered trademarks or 

trademarks of Google LLC.
• Mixcloud and Mixcloud logo are trademarks or registered trademarks of Mixcloud 

Limited.
• Intel® is a registered trademark of Intel Corporation in the U.S. and other 

countries.
• Wi-Fi is a registered mark of the Wi-Fi Alliance.
• ASIO is a trademark and software of Steinberg Media Technologies GmbH.
• Other product, technology and company names, etc. mentioned herein are 

trademarks or registered trademarks of their respective owners.

©2020 AlphaTheta Corporation.
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